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Executive summary 
To offer its readers professional, high quality reports, the Texas Water Development 
Board (TWDB) has developed formatting guidelines for its staff and contractors. These 
guidelines include information on text, graphic, and referencing standards. 

Most reports will include an Executive Summary, which will be the first numbered 
heading in the report. An effective summary should be no longer than 10 percent of the 
document length. (In other words, an Executive Summary for a 100-page paper should 
be 10 pages or less.) Because some readers will only read the Executive Summary, write 
it so that it can be read independently of the report. Do not refer to tables and figures 
from the report text in the Executive Summary and always include any significant 
recommendations and findings. 

More than one reader will share Winston Churchill's sentiment: "Please be good enough 
to put your conclusions and recommendations on one sheet of paper at the very 
beginning of your report, so that I can even consider reading it." Your Executive 
Summary may determine whether someone reads the rest of your report. 

1 Introduction11 

The purpose of this document is to describe the required format of Texas Water 
Development Board (TWDB) reports, both those written by in-house staff and those by 
contractors. Our reason for standardizing the format is to provide a consistent and, 
therefore, familiar format to our readers. Remember that your report will not only be 
seen by TWDB staff but also by any person interested in the results of your study. A 
professional and high-quality report will reflect well on the authors and TWDB. 

We will provide a Microsoft Word template (used to write these instructions) that gives 
the fonts, spacing, and other specifications for the headings and text of the report. Please 
follow this template as closely as possible. 

2 Formatting your report 
The TWDB format is designed for simplicity. For example, we use Cambria for all text. 
(The exception to this is graphics. Please use Arial in all figures.) We use 12-point, single-
spaced text, left justification for paragraph text, 16-point bold for first-level headings, 
and 14-point bold for second-level headings. Page numbers are centered at the bottom of 
the page. A header with the name of the report and TWDB contract number should 
appear at the top of each page, beginning with page ii. 

 
11 This is a level 1 heading. Note: The header is 16-point Cambria. 
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2.1 Text12 
The best way to format your document is to use the styles described and embedded in 
this template document. In addition, a list of the formatting styles is included in the 
appendix of this document. 

Because different computers have different defaults, when you use this document, your 
computer may add its own default styles to the template. If that happens, it can make 
formatting your document more difficult. To be certain that you are using only the TWDB 
styles, compare the styles that appear in your Styles and Formatting window with those 
in the screen capture on the following page (Figure 2-1). Delete any styles in your 
formatting window that do not appear in this screen capture to eliminate unwanted default 
styles. 

To ensure that your computer does not add its default styles to this document or to the 
template, before you open them go to Tools→Templates and Add Ins→Templates. Be 
sure that the box for "Automatically update document styles" is NOT checked. 

2.1.1 Title13 

Give your report a title that gives the reader an idea of the topic of your report but is not 
terribly long. In addition to the general subject (for example, “Droughts”), you may 
include a few additional words to describe a place, methodology, or other detail focused 
on throughout the paper (for example, “Droughts in the High Plains of Texas” or 
“Evaluating the Effects of Drought Using Groundwater Flow Modeling”). Please capitalize 
only the first letter of each major word (usually any word that is four letters or more). Do 
not capitalize words like "the," "and," "to," and "of." 

2.1.2 Headings 

Use headings to help the reader follow you through the main sections of your report and 
to make it easier for readers to skim through your report to find sections that might be 
the most interesting or useful to them. Headings for up to five levels of subdivision are 
provided in the template; however, we suggest not using more than three or four levels 
of subdivision except where necessary. Please avoid stacked headings (for example, a 
Heading 1 followed immediately by a Heading 2) and capitalize only the first word of 
headings—never use all caps. 

Using the headings in the Styles and Formatting window allows Word to automatically 
number your headings and then renumber them if you add or delete headings. They are 
the basis for your table of contents and also comply with the accessibility requirements. 

2.1.3 Table of contents 

The table of contents can be automatically generated from the level 1 and 2 headings. To 
generate a table of contents, place your cursor where you want it to insert it, go to 

 
12 This is a level 2 heading. Note: the head is 14-point Cambria. 
13 Level 3 heading 
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Insert→Reference→Index and Tables. Choose the table of contents tab and click on OK. 

 2.1.4 Margins 

Use 1-inch margins on all four sides of the page. 

 

 

 
 
Figure 2-1  TWDB formatting styles 

 

2.1.5 Page numbers and page headers 

Page numbers are centered at the bottom of the page in 12-point Cambria. Please use 
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roman numerals for the front matter of your report (the title page, Table of Contents, and 
lists of figures and tables). Begin with page 1 on the first page of text (normally the 
Executive Summary). Page headers are 10-point. italic Cambria, centered at the top of the 
page. (See the headers in this document for an example.) Headers on contract reports 
will read: Texas Water Development Board Contract Report Number ###, followed with 
the title of the report. 

2.2 Front matter 
The first few pages of your document should include in this order: title page and then 
table of contents (which will include a list of figures and list of tables). Both of these 
pages typically begin on an odd-numbered page. Any special pages, such as a "Note from 
the Authors," should be inserted before the Table of Contents on an odd-numbered page. 

2.3 Creating publication-quality graphics 
When designing a graphic, make sure that it (1) emphasizes the important information 
and does not show unnecessary data, lines, or labels; (2) includes the needed support 
material for the reader to understand what you are showing; and (3) is readable (see 
figures at the end of this document for examples). Edward R. Tufte’s books on presenting 
information (Tufte, 1983; 1990; 1997) are great references on good graphic design. 
Figure 2-2, Figure 2-3, and Figure 2-4 are examples of properly formatted, easy-to-
understand graphics. Please do not include fonts that are less than 7 points. 

For good-looking graphics, the resolution needs to be high enough to provide a clear 
image at the size you make them within the report. In general, 400 dpi will make a clear 
image. Try to create your figures at the same size they will be in the report, as resizing 
them in Word greatly reduces image quality. Photographs taken with at least a two-
megapixel camera (if using digital) and with good contrast will make the best images. 
Please save the original, and then adjust color levels and size in a renamed image copy. 
Please print a draft copy of your report to double check that your figures and 
photographs have clear lines and show all the features that you want them to have, 
preferably in color and/or black and white. 

Figures and photographs should be in grayscale. Also remember that your report may be 
photocopied, scanned, or downloaded and printed in black and white. For this reason, 
you should use symbols, patterns, and colors that print as different shades in black and 
white. All interval or ratio data (data measuring continuous phenomena, with each color 
representing an equal interval) need to be displayed in a graded scale of a single color 
(Figure 2-5). This way your figures will be useful even as a photocopy. 

2.3.1 Figures and photographs 

To publish professional-looking graphics, we need all originals to be saved at 400 
dots-per- inch (dpi) and in grayscale, if possible, or in the CMYK color format if color is 
necessary. Excessive use of color, especially color graphics that do not also work in 
grayscale, are sometimes difficult for the reader to print in black and white (color 
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reproduction costs can be prohibitive). Preferred file formats for your original graphics 
are Adobe Illustrator (.ai), EPS with .tif preview, jpg, .png, or .tif files. Please do not 
submit Microsoft Excel graphics. Because it is difficult to create well-designed, polished 
graphics with this program, we prefer Adobe Illustrator. It allows us more flexibility in 
adjusting fonts, colors, positions, and other graphic characteristics. 

Please refrain from using low resolution .jpg or .gif files. Internet images at 72 dpi are 
unacceptable for use in reports. 

All graphics shall be submitted in two forms: 

1. Inserted into the Microsoft Word document before you submit your report. 
Ideally, inserted graphics should be centered on the page. Format the picture 
to downsize to 6 inches wide if necessary. Please do not upsize a graphic in 
Word. Final reports should not have the graphics at the end of each chapter or 
section. 

2. Saved in one of the formats listed above. 

2.3.2 Consistency 

As readers move within a graphic or from one graphic to the next, they expect to see 
consistent fonts and font sizes. In TWDB reports, all figures should use Arial, and point 
sizes should be the same throughout the document. Point sizes should be no smaller than 
7 points. See Figures 2-2 and 2-3 for further information. 

2.3.3 Using other people’s graphics 

Figures and photographs (and tables) need to be your own unless you have written 
permission from the publisher that allows us to reprint them (we will need a copy of this 
permission for our records). Avoid using any figures or photographs taken off the 
Internet or from newspapers or magazines. It is often time consuming and expensive to 
gain permission to reproduce them. 

2.3.4 GIS and graphics 

When exporting graphics or maps out of a geographic information system such as 
ArcInfo, please be sure to export your graphics and maps in a raster format such as .jpg 
or .tif (see guidance above). If you export in a vector format, such as Windows Metafile, 
there is a good chance that your graphics will not work on all computers. Because 
geographic information systems often use specialized font sets for symbols (such as for 
point data or north arrows), readers would have to have the same specialized fonts to 
see the graphics and maps properly. By saving your graphic and maps in a raster format, 
you have essentially turned them into photographs that no longer require specialized 
fonts. 

2.3.5 Other graphics specifications 

It is easiest to design your figures separately and add them in after the text of your report 
is more or less complete. Graphics should remain within the 1-inch page margins of the 
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template (6.5 inches maximum graphic width). Please avoid landscape orientation 
because it makes the report more difficult to read. Be sure that the graphics (as well as 
tables) are numbered in the same order that they are mentioned in the text. Figures 
should appear in the report after being called out in the text. Within the graphics, please 
use Arial typeface. 

2.3.6 Captions 

Because we cannot edit captions embedded in figures, please include a caption for each 
graphic in Word. For figures and photographs, the caption should appear below the 
graphic, flush left in 10-point boldface Cambria. Table captions, however, should appear 
above the tables, flush left also in 10-point boldface Cambria. 

Automatic caption features and lists of figures and tables 

This document is set up to take advantage of automatic caption features for lists of 
figures and tables. To generate a caption, go to Insert→Reference→Caption. You will need 
to select whether it is a table or figure caption. The menu will show you the appropriate 
caption number. Click on "OK" and the caption number will be inserted in your document 
in the correct format. Then type in your caption. It will generate the correct fonts as you 
type. 

It is important to use this automatic feature because it will generate the lists of figures 
and tables for the table of contents. To create these lists, go to Insert→Reference→ Index 
and Tables. Then select the list of figures or list of tables and click on ok. This will fill in 
your lists for you. 

Because this feature picks up the entire caption, most of the time you will have to edit the 
entries in the Lists of Figures/Tables to make them more concise. If you need to update 
these lists later to reflect changes, place your cursor outside the lists and press F9. 

2.3.7 Figure formatting summary 

• Place caption underneath figure, flush left. 
• Capitalize the first word of the caption. 
• Capitalize only the first word in the axis labels and tags (unless they are proper 

names). 
• Place reference citations, if needed, within parentheses at the end of the caption. 

Do not cite TWDB if it is the only source of data. 
• Use abbreviations, acronyms, and symbols sparingly. If needed because of limited 

space, please define them in legend or caption. 
• Use Arial typeface. 
• Use consistent point size for figure text, such as axis labels. Point sizes should 

be no smaller than 7 point. 
• Use 400 dpi resolution for graphics. 
• Use a maximum graphic width of 6.5 inches. 
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2.3.8 Figure examples 

The following figures provide examples for graphs, charts, and maps. 

 

 

Figure 2-2 Font and design expectations for a bar chart (author, date). 
 

Note that there are no grid lines. If a reference were necessary, it would go in 
parentheses before the period. 
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Figure 2-3. Font and design expectations for a line chart (data from TWDB and author, date; author, 

date). 

 

Note that there are grid lines in a line chart. Also note the use of multiple citations in the 
caption. 
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Figure 2-4. A sample subject area map, giving the reader enough information to understand the 
location being discussed in this conference. For map figures, be sure to include a north 
arrow to orient the reader, a scale, and, if needed, a submap that places the figure in 
greater geographic context. Be sure that text is readable and that any citations listed 
on the figure or in the figure caption are included in the reference list. Font size 
should never be less than 7 points. 
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Figure 2-5. Initial hydraulic heads used in model simulations for layer 1. Note the use of grayscale 

shading to show differences. MSL = mean sea  level. 

 

Use abbreviations and acronyms only when necessary, and always define them. 

 

2.4 Tables 
Tables should be created in Microsoft Word (Table 2-1). They should use outlining and 
bold font only to emphasize headings, totals, or other important points. All table text is in 
Cambria. 

Table 2-1. A sample table. Note caption above table. Year and volume (acre-feet)a
 

Column head 1950 1980 1990 2000 1980 1990 2000 %GWb
 

Table text 16,015 22,441 23,340 25,926 81,196 144,522 66,083 97.4 
Winkler 10,064 9,944 8,626 7,173 8,356 3,171 5,516 99.9 

Total: 255,811 549,592 660,934 754,099 621,194 310,308 447,935  
Note: Any explanatory table information should immediately follow the table. 
Source: USGS (2000) Any table source should be next. (Please note this is not really USGS data.) 
a Please use superscript letters for table footnotes. A footnote should look like this, using 10-point Cambria. 
Table headings are 12 point (the Year and volume heading). Table text is 10 point. 
b%GW = percent groundwater. It is preferable to avoid abbreviations and acronyms. However, when 
they are necessary because of limited space, be sure to explain them. 
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2.4.1 Table formatting summary 

• Justify numbers by their decimal points. 
• Use commas beginning with thousands (1,000, 3,500, 10,000). 
• Place reference information at the bottom of the table. If the table includes 

information generated solely by TWDB, it does not need a reference. 
• Use Cambria for all text. 
• Use 12 point for table headings and 10 point for table text. 
• Capitalize only the first word of the caption and only the first word of any 

column and row heads and labels. 
• Place caption flush left above the table in 10-point bold Cambria. Place a period at 

the end of the caption. 
• Number tables consecutively (Table 1, Table 2). In long papers with numerous 

sections, number the tables with the section numbers (Table 1-1, 1-2, 2-1, 2-2, 2-
3, and so on). 

• Use acronyms and abbreviations sparingly. If you must use them because of 
limited space, define them at the bottom of the table. 

• Avoid using vertical grid lines. 
• Avoid merging fields, to be compliant with accessibility requirements. 

2.5 Units 
Measurements should be in English units. Metric units may be included in parentheses 
after the English units; however, if you include metric units, you should include them for 
all English measurements. 

All units of geologic time should conform to the most recent geologic timescale 
(Gradstein and others, 2004). A summary of this timescale is available from the 
International Commission on Stratigraphy’s website at http://stratigraphy.org/chus.pdf. 

2.6 Citations and references 
It is important to give credit where credit is due. Therefore, be sure to use the 
appropriate citations and include references in your paper. 

2.6.1 In-text citations 

Each piece of information you use in your report that comes from an outside source must 
be cited within the text using the author’s last name and the year of publication. If there 
are two authors, list the last name of each followed by the year, and if there are more 
than two authors, list the last name of the first author followed by “and others” and the 
year. For example: the end of the Jurassic Period occurred approximately 145.5 million 
years ago (Gradstein and others, 2004). If the author is an organization you may use an 
acronym and then spell it out in the Reference list, for example (TGPC, 2000). See the last 
entry in the list of references for the bibliographic entry. 

http://stratigraphy.org/chus.pdf
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2.6.2 References 

All sources that are cited within the report should be listed at the end of the paper under 
the heading References. The references should follow the guidelines in “Suggestions to 
Authors of the Reports of the United States Geological Survey” (Hansen, 1991). These are 
available online at http://www.nwrc.usgs.gov/lib/lib_sta.html (a link to the chapter 
“Preparing references for Survey reports,” p. 234–241, is found here). Several examples 
of complete reference citations are listed at the end of these guidelines. Be sure that any 
citations that appear in tables or figures are included in the reference list. Also, before 
submitting the report, please check that all the citations in the report are included in the 
reference list and all references in the reference list are cited in the report. If at all 
possible, avoid web-based citations. These materials are often transient and, therefore, 
useless to future readers. However, if you do need to use them, please include a date 
accessed. 

2.7 Acknowledgments 
Be sure to acknowledge the people and entities that assisted you in your study and 
report. If there was an outside funding source, you will need to include them at the end of 
the report, as well as on page ii. For example: 

We would like to thank the Keck Geology Consortium, the American Society of Civil 
Engineers, and the Texas Bar CLE for providing examples to use in developing these 
guidelines. In addition, we appreciate Mike Parcher for providing information on how to 
create publication- quality graphics and Ian Jones for providing Figure 10-1. 

2.8 Submitting your report 
Before you submit your report, proofread it. Look for spelling and grammatical errors. 
Also, check to see that you have structured the headings, paragraphs, and sentences in 
your paper so that it is easy to follow and understand (imagine you are a reader who 
does not already know the information you are presenting).  

2.9 Conclusions 
Following the instructions above and providing accurate and readable text, tables, 
figures, and citations will help to make your report useful to readers. Scientists may read 
your report, as well as water planners, utility providers, and interested citizens. If your 
report successfully conveys accurate scientific information and explanations to these 
readers, we can help to create more informed decisions about the use, development, and 
management of water in the state. 

http://www.nwrc.usgs.gov/lib/lib_sta.htm
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TGPC (Texas Groundwater Protection Committee), 2006, Joint groundwater and 
contamination report—2004: Texas Commission on Environmental Quality Report 
SFR 056/05, variously paginated. 

4 Appendix 
If you have an appendix in your document, it should be the last numbered section of the 
report. 

Samples of font, spacing requirements: 

 

Title page TWDB heading 22 pt., bold 

Title page title 18 pt.;  

Author List title page: 12 pt.; 0.5" indent 

 

Body text:  

All text is Cambria 12 pt. font, indent left 0.07”, right 0.09”, space, After paragraph add 12 
pt. font space 

5 Heading 1 
16 pt. bold; no left indent; hanging indent 0.25 inches; 12 pt. space before; 6 pt. space 
after; keep with next; outline numbered, numbering style 1,2,3 

5.1 Heading 2 
14 pt. bold; no left indent; hanging indent 0.4 inches; 12 pt. space before; 6 pt. space 



Texas Water Development Board Contract Number 2048300000 
Final Report: Formatting Guidelines for Texas Water Development Board Reports 

 

15 
 

after; keep with next; outline numbered 1.1, 1.2 

5.1.1 Heading 3 

12 pt. bold italic; no left indent; hanging indent 0.5"; 12 pt. space before; 6 pt. space after; 
keep with next; outline numbered 1.1.1, 1.1.2 

Heading 4 

12 pt. bold; no indent; 3 pt. space before; 3 pt. space after; no outline numbering  

List paragraph  

12 pt. Cambria, single space, 6 pt. before, 6 pt. after  

Bulleted List 

• Left indent 0.25 inches 
• Hanging indent 0.25 inches 
• 3 pt. space before and after Numbered list 

 
 

Table 5-1. Caption 10 pt. bold; hanging indent 1"; 18 pt. space before; 12 pt. space after; tabs 
1"; automatically update. Table captions precede the table. Figure captions are 
placed below the figure. 

 

Year and volume (acre-feet) 

Column head 1950 1980 1990 2000 1980 1990 2000 %GWb
 

Table text 16,015 22,441 23,340 25,926 81,196 144,522 66,083 97.4 
Winkler 10,064 9,944 8,626 7,173 8,356 3,171 5,516 99.9 

Total: 255,815 49,592 660,934 754,099 621,194 310,308 447,935  

 
Table text headings: 12 pt.; single spacing; centered 

Table column heads: 10 pt. bold; single spacing 
 

Table text: 10 pt.; single spacing 
 

References: No left indent; hanging indent 0.25 inches; 6 pt. space before Header: 10 pt. 
centered (should contain title of report, shortened, if necessary) 

Footer/Header: 12 pt. centered 
 

Footnotes:10 pt.; 3 pt. space after 
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